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Κωδ: ΣΥΝΤΗΛ,  
ΣΥΝΤΗΛ-1, ΣΥΝΤΗΛ-2 

ΠΟΛΥΛΕΙΤΟΥΡΓΙΚΟ ΟΙΚΙΑΚΟ ΣΥΣΤΗΜΑ ΣΥΝΑΓΕΡΜΟΥ FCT-31A 
Ο∆ΗΓΙΕΣ ΧΡΗΣΗΣ 

 

Παρακαλούµε διαβάστε τις οδηγίες χρήσης προσεκτικά και φυλάξτε τις για µελλοντική αναφορά. 
 

1. ΣΥΝΤΟΜΗ ΕΙΣΑΓΩΓΗ 
Το πολυλειτουργικό οικιακό σύστηµα συναγερµού FCT-31A είναι µία πολυλειτουργική συσκευή µε ενσωµατωµένο τηλέφωνο 
GSM και οικιακό συναγερµό. Με τη βοήθεια διαφόρων αξιόπιστων αισθητήρων και λειτουργίας επικοινωνίας GSM (κλήσεις και 
γραπτά µηνύµατα), ο ιδιοκτήτης του σπιτιού θα έχει τη δυνατότητα να χειρίζεται εύκολα την ασφάλεια του σπιτιού. 
 

� Λειτουργίες και Χαρακτηριστικά 
 Τηλέφωνο GSM: Κλήση & Λήψη Κλήσεων 
 Λειτουργία γραπτών µηνυµάτων: 

- Αποστολή & Λήψη & Αποθήκευση γραπτών µηνυµάτων 
- Πρότυπα γραπτών µηνυµάτων: προκαθορισµένα και γρήγορη αποστολή 

 Λειτουργία τηλεφωνικού καταλόγου: ∆ιόρθωση & Αναζήτηση & Αποθήκευση & Κλήση 
 Περιορισµένες εισερχόµενες κλήσεις και γραπτά µηνύµατα: Μαύρη λίστα και λευκή λίστα 
 Λειτουργία αναφοράς 

- Αναφορά παιδιών 
- Καταγραφή εργασιών 

 Ειδοποίηση γραπτών µηνυµάτων και λειτουργία αφοπλισµού 
 Υποστηριζόµενο από κωδικό ασφαλείας 
 Καθυστέρηση συναγερµού και ειδοποίησης 
 Εφεδρική µπαταρία: Προστασία παροχής ρεύµατος 
 Ολοκληρωτική ή µερική άµυνα 
 Φύλαξη κατά κλοπής, πυρκαγιάς, διαρροής αερίου κλπ. 
 SOS: Στη λειτουργία έκτακτης ανάγκης (ηλικιωµένοι ή παιδιά) πιέζουν το κουµπί των τερµατικών ή του χειριστηρίου για να 

στείλουν σήµα κινδύνου. 
 Προοδευµένη τεχνολογία κρυπτογράφησης 
 Κωδικός υψηλού επιπέδου ασφαλείας 
 Εύκολη εγκατάσταση και χρήση 

 

� Λεπτοµερής παρουσίαση 
 ∆ίκτυο GSM 900 / 1800 / 1900ΜΗz (850 MHz προαιρετικά) 
 Κεραία GSM: 

- Κινητή κεραία: απολαβή 4dBi, µήκος καλωδίου 3 -5 µέτρα, σύνδεση SMA 
- Φορητή κεραία: απολαβή 2dBi, ύψος 10 εκατοστά, σύνδεση SMA 

 Συχνότητα λήψης: 433 / 315MHz (2240 / 1257 κωδικός µελέτης) 
 Ευαισθησία λήψης: ≤0.1uv 
 Περιβάλλον λειτουργίας: 

- Θερµοκρασία: -10 – +50°C 
- Υγρασία: 20% – 95%  

 Παροχή ρεύµατος: Είσοδος: AC 110 ~ 240V – Έξοδος: DC 7.5 1.5Α (προαιρετικά DC 12V 1Α) 
 Εφεδρική µπαταρία: Lithium Polymer 600 mAh 3.7V 
 Βάρος: Βάρος συσκευασίας: 1.8 κιλά / τεµάχιο 
 ∆ιαστάσεις συσκευασίας (mm): 325 * 310 * 72 

 

� Εξαρτήµατα 
Βασική Συσκευασία Ποσότητα 
Κεντρική Μονάδα 1 
Κεραία GSM 2 
Τηλεχειριστήριο 3 
Μαγνητικός αισθητήρας πόρτας / παραθύρου 2 
Αισθητήρας υπέρυθρων: PIR-H 1 
Σειρήνα 1 
Μετασχηµατιστής  1 
Εφεδρική µπαταρία 1 

 
Προαιρετικός Ανιχνευτής Ποσότητα 
Ανιχνευτής καπνού 
Ανιχνευτής διαρροής αερίου 
Αισθητήρας υπέρυθρων: PIR 
Αισθητήρας τραντάγµατος 

 
Ζώνη 4 – 14: Περιοχή άµυνας 
Ζώνη 15 – 16: Ειδική περιοχή άµυνας 

 

� Τηλεχειριστήριο:  
Συχνότητα λειτουργίας: 433M / 1527 τύπος µελέτης 
Βολτ λειτουργίας: 12V (27A 12V µπαταρία ξηρού τύπου) 
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Απόσταση ελέγχου: 20 – 100 µέτρα 
      Πλήκτρο ενεργοποίησης ολοκληρωτικού συναγερµού (συναγερµός ολοκληρωτικής άµυνας) 
      Πλήκτρο ενεργοποίησης τοπικού συναγερµού (συναγερµός κυρίως άµυνας) 
      Πλήκτρο αφοπλισµού Πιέστε το πλήκτρο για αφόπλιση του συναγερµού 
      SOS πλήκτρο έκτακτης ανάγκης Πιέστε το πλήκτρο για να ενεργοποιήσετε το SOS έκτακτης ανάγκης 
 

Σηµείωση: Η ένδειξη LED του τηλεχειριστηρίου αρχίζει να αναβοσβήνει όταν πατηθεί το αντίστοιχο πλήκτρο. Αλλάξτε την 
µπαταρία όταν το LED που αναβοσβήνει γίνει αχνό. 
 

2. ΕΓΚΑΤΑΣΤΑΣΗ 
ΠΡΟΣΟΧΗ: 
 Το τερµατικό θα πρέπει να είναι εγκατεστηµένο σε ένα σηµείο µε δυνατό και σταθερό δίκτυο GSM. 
 Το τερµατικό δεν θα πρέπει ποτέ να τοποθετείται µαζί µε αντικείµενα που µπορεί να προκαλέσουν µεγάλη ηλεκτροµαγνητική 

παρεµβολή. 
 Η απόσταση µεταξύ του κυρίως τερµατικού και κάθε ασύρµατου αισθητήρα δεν θα πρέπει να είναι µεγαλύτερη των 100 

µέτρων. 
 Το τερµατικό θα πρέπει να είναι εγκατεστηµένο σε κάποιο κατάλληλο σηµείο, χωρίς σκόνη, δονήσεις, υγρασία, απευθείας 

ηλιακό φως, υψηλή θερµοκρασία ή πολύ χαµηλή θερµοκρασία. 
 Ποτέ µην επιχειρείτε να τροποποιήσετε την εσωτερική δοµή του τερµατικού. 
 Αυτή η συσκευή χρειάζεται για να δουλέψει µία έγκυρη κάρτα SIM. 

 

� Εγκατάσταση του κυρίως πλαισίου  
 
 
 
 
 
 
 
 
 

1. Ανοίξτε το κάλυµµα της κάρτας SIM που βρίσκεται στο κάτω µέρος του κυρίως πλαισίου και εισάγετε την κάρτα GSM SIM 
στην υποδοχή. 
 
 
 
 
 
 
 

2. Βεβαιωθείτε ότι η µπαταρία είναι σωστά τοποθετηµένη. 
3. Εγκαταστήστε την κεραία GSM και τη Σειρήνα. 

 
 
 
 
 
 
 

4. Βάλτε το µετασχηµατιστή σε πρίζα µε κατάλληλη παροχή ρεύµατος. Εισάγετε την έξοδο DC στη θύρα παροχής ρεύµατος 
που βρίσκεται πάνω στο κυρίως τερµατικό. 

5. Επιβεβαιώστε ότι η εγκατάσταση έχει γίνει σωστά και ενεργοποιήστε το τερµατικό µε το διακόπτη. Ελέγξτε αν η ένδειξη 
λειτουργίας δουλεύει σωστά. 

 

� Εγκατάσταση του κυρίως πλαισίου  
Παρακαλούµε δείτε το Παράρτηµα. 
 

3. ΠΛΗΚΤΡΟΛΟΓΙΟ & ΛΕΙΤΟΥΡΓΙΕΣ 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
ON/OFF Παροχή ρεύµατος Για εργοστασιακή χρήση µόνο 

 

Η άνω όψη της κάρτας προς τα κάτω 

 

 



  

 

 
Τηλεµάρκετινγκ Α.Ε. Σολωµού 56, 14234 Ν.Ιωνία 210-2708250 www.tmstore.gr Σελίδα 3 από 12 

tmstore.gr 

Πλήκτρο Εντολής Πλήκτρο Λειτουργία 
Σε κατάσταση αναµονής 

� Βέλος που δείχνει προς τα πάνω Έλεγχος αναπάντητων κλήσεων (µέγιστος αριθµός 20). 
Ανασκόπηση του αριθµού και του ονόµατος µε το 
πλήκτρο � ή � 

� • Βέλος που δείχνει προς τα κάτω 
• Κατά τη διάρκεια της εισαγωγής, αλλαγή 
 

 

⊳� Τοποθέτηση δροµέα 
Πλήκτρο αριστερής ή δεξιάς κατεύθυνσης 

Ελέγχος εξερχόµενων κλήσεων (µέγιστος αριθµός 20). 
Ανασκόπηση του αριθµού και του ονόµατος µε το 
πλήκτρο � ή � 

MENU Αλλαγή λειτουργίας στο υποµενού Πιέστε το για να εισέλθετε στο µενού 
ΟΚ Επιλογή στη λειτουργία µενού Πιέστε το για να εισέλθετε στον τηλεφωνικό κατάλογο 

ΕΧΙΤ Ακύρωση στη λειτουργία µενού Πιέστε το για να εισέλθετε στο µενού γραπτών 
µηνυµάτων 

  Ρύθµιση Ολοκληρωτικής ή Τοπικής Λειτουργίας 
Συναγερµού 

 
 

 Αφόπλιση συστήµατος 

! Παράκληση για βοήθεια έκτακτης ανάγκης  
 
 

 Πιέστε το για να εισέλθετε στα πρότυπα γραπτά 
µηνύµατα 

VOLUME+/- Ρύθµιση της έντασης του τόνου και του ήχου 
κλήσης 

 

REDIAL Επανάκληση της τελευταίας εξερχόµενης κλήσης  
 
 

Κλήση µε µεγάφωνο  

Number Key Αλφαρηθµιτικό πλήκτρο  
* Κατά τη διάρκεια της εισαγωγής: ακύρωση 

εισαγωγής 
 

# Κατά τη διάρκεια της εισαγωγής: πλήκτρο κενού  
 

� LED γραπτών µηνυµάτων: Ανάβει πιο έντονα όταν λαµβάνεται καινούργιο γραπτό µήνυµα.  
 

� Σύµβολα της οθόνης  

 

Σήµα δικτύου 
 

Κλήση 
 

Μη αναγνωσµένα γραπτά µηνύµατα 
 

Ενεργοποιηµένη µαύρη λίστα 
 

Ενεργοποιηµένη λευκή λίστα 
 

Προειδοποίηση σειρήνας 

 
Οπλισµένο 
 

Τοπικά οπλισµένο 
 

Παροχή ρεύµατος 
 

Κατάσταση µπαταρίας 
 

Επίπεδο έντασης ήχου 

 

� Μέθοδος Εισαγωγής  
Αριθµός:  Πιέστε � >      Αριθµητική κατάσταση > Πιέστε τα πλήκτρα των αριθµών 
Γράµµα:  - Κεφαλαία: Πιέστε � >     Κατάσταση > Εισάγετε το αντίστοιχο γράµµα 
   - Πεζά: Πιέστε � >     Κατάσταση > Εισάγετε το αντίστοιχο γράµµα 
Κενό:   Πιέστε το πλήκτρο # 
Χαρακτήρας:  Στην κατάσταση           , πιέστε το πλήκτρο 0 για εισαγωγή χαρακτήρων 
∆ιαγραφή:  Πιέστε το πλήκτρο * για να διαγράψετε τον αριθµό ή το γράµµα πριν τον δροµέα 
Θέση δροµέα:  Πλήκτρα ⊳ ΑΡΙΣΤΕΡΑ / � ∆ΕΞΙΑ  
Αλλαγή οθόνης: ���� ΠΑΝΩ 
∆ιακόπτης εισαγωγής: Πιέστε το πλήκτρο � ΚΑΤΩ για να αλλάξετε µεταξύ  
 

4. ΤΗΛΕΦΩΝΟ 
4.1 Λειτουργία: 
� Κλήση:   

- Στη κατάσταση αναµονής, πιέστε το πλήκτρο του µεγαφώνου ή σηκώστε το ακουστικό, πληκτρολογήστε τον επιθυµητό 
αριθµό και πιέστε το πλήκτρο ΟΚ για να πραγµατοποιήσετε µια κλήση. 
- Με το call>ok στο Μενού, καλείτε τον επιθυµητό αριθµό. 

� Λήψη κλήσεων: Όταν χτυπά το τηλέφωνο, σηκώστε το ακουστικό ή πιέστε το πλήκτρο      για να λάβετε την κλήση. Η 
συσκευή δείχνει τον αριθµό που σας καλεί ή το όνοµα αυτού που σας καλεί.  

� Hands free: Μιλάτε χωρίς ακουστικό όταν πληκτρολογείτε ή όταν λαµβάνετε κλήσεις. 
� Λειτουργία κατά την κλήση: Ρύθµιση της έντασης του ήχου 
 

4.2 Περιορισµός εισερχόµενων κλήσεων 
� Μαύρη λίστα: Όταν είναι ενεργοποιηµένη η λειτουργία Μαύρης λίστας, η οθόνη LCD δείχνει το σύµβολο    , και δεν 
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δέχεστε κλήσεις ή γραπτά µηνύµατα από 20 αριθµούς της Μαύρης λίστας. 
� Λευκή λίστα: Όταν είναι ενεργοποιηµένη η λειτουργία Λευκής λίστας, η οθόνη LCD δείχνει το σύµβολο      , και µπορείτε να 

λάβετε κλήσεις ή γραπτά µηνύµατα µόνο από 20 αριθµούς της Λευκής λίστας. Οι υπόλοιποι αριθµοί που δεν είναι 
καταχωρηµένοι στη Λευκή λίστα αυτοµάτως θα απορρίπτονται. 

 

5. ΛΕΙΤΟΥΡΓΙΕΣ ΜΕΝΟΥ 
Στην κατάσταση αναµονής, πιέστε το πλήκτρο MENU του πληκτρολογίου του τηλεφώνου για να εµφανιστεί το κυρίως µενού: 
Πλήκτρα ��������: Επισκόπηση των επιλογών του κυρίως µενού 
Επιλογή: Πλήκτρο ΟΚ 
Ακύρωση: Πλήκτρο ΕΧΙΤ 
Εναλλαγή λειτουργιών στο υπο-µενού: πλήκτρο MENU 
1. SMS (γραπτά µηνύµατα) 
2. Phone Book (τηλεφωνικός κατάλογος) 
3. Call Log (ηµερολόγιο κλήσεων) 
4. Phone Setup (ρύθµιση τηλεφώνου) 
5. Alarm Setup (ρύθµιση ειδοποίησης) 
 

5.1 ΓΡΑΠΤΑ ΜΗΝΥΜΑΤΑ (SMS) 
5.1.1 Λήψη γραπτών µηνυµάτων (SMS) 
1. Inbox (εισερχόµενα) 
2. Sent Items (απεσταλµένα) 
3. Draft (πρόχειρα) 
4. Create SMS (δηµιουργία γραπτού µηνύµατος) 
5. Template (πρότυπα) 
 

Όταν έρχεται ένα καινούργιο γραπτό µήνυµα, το LED των γραπτών µηνυµάτων ανάβει και εµφανίζεται στην οθόνη το σύµβολο  
Πιέστε το πλήκτρο ΕΧΙΤ ή πιέστε το Menu > Inbox για να διαβάσετε το γραπτό µήνυµα. 
Το νεότερο γραπτό µήνυµα εµφανίζεται στο πάνω µέρος της λίστας γραπτών µηνυµάτων. Ο µέγιστος αριθµός γραπτών 
µηνυµάτων που µπορεί να αποθηκευτεί, εξαρτάται από τη χωρητικότητα της κάρτας SIM. Ο χρήστης θα πρέπει να σβήσει ο ίδιος 
κάποια γραπτά µηνύµατα, όταν εµφανιστεί η ένδειξη SMS FULL (δηλαδή ότι η µνήµη των γραπτών µηνυµάτων είναι πλήρης) 
στην οθόνη. 
 

Όριο λήψης γραπτών µηνυµάτων 
• Μαύρη λίστα / Λευκή λίστα: Αναφερθείτε στον Περιορισµό εισερχόµενων κλήσεων 
• Αν τα εισερχόµενα είναι πλήρη, δεν θα µπορείτε να λαµβάνετε άλλα γραπτά µηνύµατα 
 

5.1.2 Αποστολή γραπτών µηνυµάτων 
� Αν θέλετε να στείλετε ένα καινούργιο γραπτό µήνυµα: 

Πιέστε MENU > 1. SMS > OK > 4. Create SMS: Ξεκινήστε να γράφετε ένα νέο γραπτό µήνυµα. 
- Το νέο µήνυµα µπορεί να αποθηκευτεί στο Draft Box (πρόχειρα) πριν το στείλετε. 
- Όταν αποστείλετε επιτυχώς το γραπτό µήνυµα, θα σωθεί στα Sent Items (απεσταλµένα). 

� Αν θέλετε να αποστείλετε ένα αποθηκευµένο γραπτό µήνυµα ή να στείλετε ένα γραπτό µήνυµα: 
Επιλέξτε το γραπτό µήνυµα από τα εισερχόµενα, τα απεσταλµένα ή τα πρόχειρα και αποστείλετέ το. 

 

5.1.3 Λειτουργία Μενού  
MENU > 1. SMS > OK 

� Εισερχόµενα  
> 1. Inbox > Πλήκτρο ⊳, �: ∆είτε τις λεπτοµέρειες κάποιου γραπτού µηνύµατος 
                  > Πλήκτρο �, �: Επιλέξτε το γραπτό µήνυµα 
> MENU ----> 
                  > Delete: ∆ιαγραφή του παρόντος γραπτού µηνύµατος 
                  > Reply: Απάντηση στον αποστολέα µε ένα νέο γραπτό µήνυµα 
                  > Call: Κλήση του αποστολέα 
                  > Add Entry: Προσθήκη του αριθµού του παρόντα αποστολέα στον τηλεφωνικό κατάλογο 
                  > Add to Black list: Προσθήκη του αριθµού του παρόντα αποστολέα στη µαύρη λίστα 
                  > Transmit: Αποστολή του παρόντος γραπτού µηνύµατος σε άλλα κινητά τηλέφωνα 

� Απεσταλµένα 
Τα ονόµατα ή οι αριθµοί των τελευταίων 10 απεσταλµένων γραπτών µηνυµάτων εµφανίζονται σε λίστα. Ανανεώνεται 
αυτόµατα. 
> 1. SMS > OK > 2. Sent Items > OK 
> MENU ----> 
> Del All: ∆ιαγραφή όλων των απεσταλµένων γραπτών µηνυµάτων  
> View: Επισκόπηση του περιεχοµένου του επιλεγµένου γραπτού µηνύµατος 
> View >  OK > Menu ----> Call (κλήση) / Send (αποστολή) / Edit (επεξεργασία) 

� Πρόχειρα 
Τα πρόχειρα αποθηκεύονται στο τερµατικό (3 αντικείµενα το µέγιστο). Ανανεώνεται αυτόµατα. 
> 1. SMS > OK > 3. Draft > OK 
> View > Menu > Del All: ∆ιαγραφή όλων των πρόχειρων γραπτών µηνυµάτων 
> View > OK > MENU --> Edit (επεξεργασία) / Send (αποστολή) 
> View > OK > MENU > Edit > OK > MENU ---> Send (αποστολή) / Clear (καθαρισµός) / Save (αποθήκευση) 
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� ∆ηµιουργία γραπτού µηνύµατος 
> 1. SMS > OK > 4. Create SMS > OK: Ξεκινήστε την επεξεργασία ενός νέου γραπτού µηνύµατος 
> MENU --> Send: Επιτυχής αποστολή. Θα αποθηκευτεί στα απεσταλµένα. 
               > Clear: ∆ιαγραφή όλου του εισαγµένου περιεχοµένου. 
               > Save: Αποθήκευση του εισαγµένου περιεχοµένου στα πρόχειρα. 

� Πρότυπα γραπτά µηνύµατα 
Υπάρχουν έξι πρότυπα γραπτά µηνύµατα (µέγιστος αριθµός χαρακτήρων ανά γραπτό µήνυµα: 30) για ηλικιωµένα άτοµα ή 
για χρήση από παιδιά. Στην κατάσταση αναµονής, πιέστε το πλήκτρο     , µετά εισάγετε τον αριθµό του επιθυµητού 
προτύπου και το επιλεγµένο πρότυπο θα αποσταλεί αυτοµάτως στον Παραλήπτη Α. 
1. SMS > OK > 5. Templates > OK 
    > MENU --> Del All: ∆ιαγραφή όλων των προτύπων 
    > MENU --> Edit (επεξεργασία) > OK 
            > MENU --> Clear: ∆ιαγραφή του εισαγµένου περιεχοµένου. 
                           > OK: Εισαγωγή ή επεξεργασία των προτύπων. 
                                    > ΟΚ: Αποθήκευση αλλαγών. 

ΣΗΜΕΙΩΣΗ: Στη λειτουργία επεξεργασίας, πιέστε τα ⊳� για να κινήσετε τον δροµέα. 
 

5.2 Τηλεφωνικός Κατάλογος 
1. Name Query (Αναζήτηση Ονόµατος) 
2. Location Query (Αναζήτηση Θέσης) 
3. Add Entry (Προσθήκη Επαφής) 
4. Contacts Limit (Όριο Επαφών) 
Σε αυτό το µενού, µπορείτε να αναζητήσετε έναν τηλεφωνικό αριθµό και να επεξεργαστείτε τον τηλεφωνικό σας κατάλογο. 

MENU > 2. Phone Book > OK > 
5.2.1 Αναζήτηση Ονόµατος 
> 1. Name Query > ok > Εισαγωγή ονόµατος αναζήτησης (Μέγιστο: 12 χαρακτήρες) 
> MENU --> Clear: ∆ιαγραφή του εισαγµένου περιεχοµένου 
> MENU --> OK: Επίδειξη των περιεχοµένων αναζήτησης > MENU --> Call (κλήση) / Delete (διαγραφή) / Edit 
(επεξεργασία) 
 

5.2.2 Αναζήτηση Θέσης 
> 2. Location Query > ok: Εισαγωγή θέσης αναζήτησης 
                                   > ok > ��������: Επισκόπηση Τηλεφωνικού Καταλόγου 
 

5.2.3 Προσθήκη Επαφής 
> 3. Add Entry > OK > Εισαγωγή του νέου αριθµού (µέγιστο µήκος: 14 ψηφία) 
                        > ΟΚ > Εισαγωγή του ονόµατος (Μέγιστο µήκος: 12 χαρακτήρες) 
                        > ΟΚ > Προσθήκη στη λευκή λίστα (Yes / No – Ναι / Όχι) 
                        > ΟΚ: Προσθήκη στη λευκή λίστα 
                        > ΟΚ: Αποθήκευση στον Τηλεφωνικό Κατάλογο 
 

5.2.4 Όριο Επαφών 
> 4. Contacts Limit > OK > 
> 1. Black list > OK > 1. On > OK: Η Μαύρη Λίστα είναι ενεργή, η οθόνη δείχνει το σύµβολο  
                                 > 2. Off > OK: Απενεργοποίηση της Μαύρης λίστας, το σύµβολο      εξαφανίζεται 
                                 > 3. Edit BL (Επεξεργασία µαύρης λίστας) > OK > MENU --- 
                                    > Delete (∆ιαγραφή) 
                                 > Delete All (∆ιαγραφή όλων) 
                                 > Add New (Προσθήκη νέας επαφής) > ��: Επισκόπηση 
                                                                                       > Edit new num (Επεξεργασία νέου αριθµού) > ΟΚ 

 

2. White list > OK > 1. On > OK: Η Λευκή Λίστα είναι ενεργή, η οθόνη δείχνει το σύµβολο  
                                 > 2. Off > OK: Απενεργοποίηση της Λευκής λίστας, το σύµβολο       εξαφανίζεται 
                                 > 3. Edit WL (Επεξεργασία λευκής λίστας) > OK > MENU --- 
                                    > Delete (∆ιαγραφή) 
                                 > Delete All (∆ιαγραφή όλων) 
                                 > Add New (Προσθήκη νέας επαφής) > ��: Επισκόπηση 
                                                                                       > Edit new num (Επεξεργασία νέου αριθµού) > ΟΚ 
 

Επεξεργασία της µαύρης λίστας και της λευκής λίστας από το Ηµερολόγιο Κλήσεων ή την Προσθήκη Επαφής 
Μπορείτε να προσθέσετε αριθµούς στη Μαύρη / Λευκή Λίστα από τις Αναπάντητες Κλήσεις / Εισερχόµενες Κλήσεις / 
Εξερχόµενες Κλήσεις / Προσθήκη Επαφής, όπως και να προσθέσετε στη µαύρη λίστα από τα Εισερχόµενα γραπτά µηνύµατα. 
 

ΣΗΜΕΙΩΣΗ: 
• Ο τηλεφωνικός κατάλογος είναι αποθηκευµένος στην κάρτα SIM. Το µέγεθός του εξαρτάται από το µέγεθος της κάρτας SIM. 
• Η Μαύρη Λίστα και η Λευκή Λίστα αποθηκεύονται στο τερµατικό (20 αριθµοί το µέγιστο). 
• Όλες οι απορριφθείσες κλήσεις θα καταγράφονται στις Αναπάντητες Κλήσεις. 

Τα απορριφθέντα γραπτά µηνύµατα δεν θα καταγράφονται. 
• Αν ελέγξετε τον Τηλεφωνικό Κατάλογο αµέσως µετά την ενεργοποίηση του τερµατικού, µπορεί να δείτε την ένδειξη SIM 

Busy (Απασχοληµένη SIM). Αν συµβεί αυτό, θα πρέπει να περιµένετε για λίγο µέχρι να µπορείτε να ελέγξετε τον Τηλεφωνικό 
Κατάλογο. 
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• Για να πραγµατοποιήσετε µια κλήση από το MENU, θα πρέπει να σηκώσετε το ακουστικό ή να πιέσετε το πλήκτρο του 
µεγαφώνου. 

 

5.3 Ηµερολόγιο Κλήσεων 
1. Dialed Numbers (Κληθέντες Αριθµοί) 
2. Received Calls (Ληφθείσες Κλήσεις) 
3. Missed Calls (Αναπάντητες Κλήσεις) 
4. Delete All (∆ιαγραφή Όλων) 

MENU > 3. Call Log > OK 
 

5.3.1 Κληθέντες Αριθµοί 
> 1. Dialed Numbers > ΟΚ 
> ��: Επισκόπηση Ηµερολογίου Κλήσεων (Μέγιστο 20 αιρθµοί): εµφάνιση σειριακού, αριθµού, ονόµατος, ώρας, ηµεροµηνίας 
και συµβόλου      (αν είναι στη µαύρη λίστα). 
> MENU ---> Call (Κλήση) > ΟΚ 
                                      > Dial Automatically (αυτόµατη κλήση) > σηκώστε το ακουστικό ή πατήστε το  
                                      > Add Entry (Προσθήκη Επαφής) 
                                      > Add Black (Προσθήκη στη µαύρη λίστα) 
                                      > Add White (Προσθήκη στη λευκή λίστα) 
 

5.3.2 Ληφθείσες Κλήσεις 
> 2. Received Calls > ΟΚ (Μέγιστο 20 αριθµοί) 
Η λειτουργία είναι ίδια όπως της παραγράφου 5.3.1 
 

5.3.3 Αναπάντητες Κλήσεις 
> 3. Missed Calls > ΟΚ (Μέγιστο 20 αριθµοί) 
Η λειτουργία είναι ίδια όπως της παραγράφου 5.3.1 
 

5.3.4 ∆ιαγραφή Όλων 
> 4. Delete All > ΟΚ > Are you sure? (Είστε σίγουροι;) 
    > ΟΚ: ∆ιαγραφή όλου του ηµερολογίου κλήσεων 
 

Σηµείωση: 
• Πιέστε το δεξί κουµπί στην κατάσταση αναµονής για να ελέγξετε τους κληθέντες αριθµούς. 
• Πατήστε το κουµπί προς τα πάνω στην κατάσταση αναµονής για να ελέγξετε τις αναπάντητες κλήσεις. 
• Όταν τα αρχεία φτάσουν τα 20, τα παλιότερα αρχεία θα διαγραφούν όταν εγγραφούν νέα αρχεία. 
 

5.4 Ρύθµιση Τηλεφώνου 
1. Ring Type (Ήχος Κλήσης) 
2. Ring Volume (Ένταση Ήχου Κλήσης) 
3. Time & Date (Ώρα & Ηµεροµηνία) 
4. Date Format (Μορφή Ηµεροµηνίας) 
5. Default Set (Προκαθορισµένη Ρύθµιση) 

MENU > 4. Phone Setup > OK > 
 

5.4.1 Ήχος Κλήσης 
> 1. Ring Type 
> Πιέστε το πλήκτρο �/� για να πάτε στο 8 (music – µουσική) και στο 6 (normal ring tones – φυσιολογικοί ήχοι κλήσης) 
> ΟΚ (για επιβεβαίωση) 
> Αποθήκευση 
 

5.4.2 Ένταση Ήχου Κλήσης  
> 2. Ring Volume > Πιέστε το πλήκτρο �/� για να πάτε στο 8 (ένταση ήχου) 
> ΟΚ (για επιβεβαίωση) 
> Αποθήκευση 
 

5.4.3 Ώρα & Ηµεροµηνία  
> 3. Time & Date > Πιέστε το πλήκτρο ⊳/� για να κινήσετε τον δροµέα 
> Πιέστε το πλήκτρο �/� για να ρυθµίσετε την ώρα και την ηµεροµηνία 
> ΟΚ (για επιβεβαίωση) 
> Αποθήκευση 
 

5.4.4 Μορφή Ηµεροµηνίας  
> 4. Date Format > Πιέστε το πλήκτρο ⊳/� ή το �/� για να κινήσετε τον δροµέα 
> ΟΚ (για επιβεβαίωση) 
> Αποθήκευση 
 

Μορφή Ηµεροµηνίας Παράδειγµα 
MM: Μήνας Μάρτιος � 03 

DD: Ηµέρα 11 � 11 

YY: Χρόνος 2008 � 08 
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5.4.5 Προκαθορισµένη Ρύθµιση 
> 5. Default Set 
> ΟΚ > Are you sure? (Είστε σίγουροι;) 
> ΟΚ: Το σύστηµα επιστρέφει στις προκαθορισµένες εργοστασιακές ρυθµίσεις 
 

Εργοστασιακές Ρυθµίσεις: 
• ∆ιαγράφονται όλοι οι αριθµοί από τη Μαύρη Λίστα και τη Λευκή Λίστα.  
• Ο κωδικός ασφαλείας είναι ο 1111. 
• ∆ιαγραφή του ηµερολογίου κλήσεων. 
• Ένταση τηλεφώνου: 10. 
• Ήχος κλήσης: 1. 
• Μορφή ηµεροµηνίας: YY – MM – DD. 
• Μορφή εισαγωγής στοιχείων: Μεγάλα κεφαλαία. 
• Καθυστέρηση όλων των συναγερµών: 3 δευτερόλεπτα. 
• Καθυστέρηση τοπικού συναγερµού: 0 δευτερόλεπτα. 
 

5.5 Ρύθµιση Συναγερµού 
1. Recipient No (Αριθµός Παραλήπτη) 
2. Power Failure (∆ιακοπή Ρεύµατος) 
3. All Alarm Delay (Καθυστέρηση Ολικού Συναγερµού) 
4. Alert Delay (Καθυστέρηση Ειδοποίησης) 
5. Change PWD (Αλλαγή Κωδικού Ασφαλείας) 
6. Edit RF Sensor (Επεξεργασία Αισθητήρα RF) 
7. RF Code Query (Αναζήτηση Κωδικού RF) 

MENU > 5. Alarm Setup > PWD > OK > 
 

5.5.1 Αριθµός Παραλήπτη 
> 1. Recipient No > OK 
> MENU ---> Delete: ∆ιαγραφή του αριθµού στον δροµέα 
> Edit (Επεξεργασία) > OK > Εισαγωγή ενός αριθµού παραλήπτη (κινητού τηλεφώνου / PSTN) > ΟΚ 
> Αποθήκευση 
 

Σηµείωση: 
• Μπορούν να υπάρξουν 3 παραλήπτες το µέγιστο. Μέγιστος αιρθµός ψηφίων: 14. Ο πρώτος παραλήπτης δεν θα πρέπει ποτέ 

να είναι κενός. 
• Στην κατάσταση συναγερµού, το τερµατικό θα στέλνει γραπτά µηνύµατα ειδοποίησης στους παραλήπτες µε κινητό 

τηλέφωνο και θα καλεί όλους τους παραλήπτες µε τη σειρά για να τους ειδοποιήσει και να ελέγχει την κατάσταση. 
 

5.5.2 ∆ιακοπή Ρεύµατος 
> 2. Power Failure > OK > On / Off > OK 

Σηµείωση: 
• Ο χρήστης επιλέγει το On: Όταν γίνει διακοπή ρεύµατος, το τερµατικό θα στείλει γραπτό µήνυµα ειδοποίησης στον πρώτο 

παραλήπτη.  
• Όταν γίνει διακοπή ρεύµατος, η ένδειξη   εξαφανίζεται. Η βοηθητική µπαταρία ξεκινά να δίνει ρεύµα. Η ένδειξη     

εµφανίζεται στην οθόνη. 
 

5.5.3 Καθυστέρηση Ολικού Συναγερµού 
> 3. All Alarm Delay > OK > ����/���� για να δείτε τη λίστα > ΟΚ για αποθήκευση 

Σηµείωση: 
• Μπορείτε να ρυθµίσετε τον χρόνο καθυστέρησης του Ολικού Συναγερµού. Χρησιµοποιείται για την πρόληψη λανθασµένης 

ενεργοποίησης του συναγερµού, όταν ο ιδιοκτήτης είναι ακόµα µέσα στο σπίτι κατά τη διάρκεια της λειτουργίας του Ολικού 
Συναγερµού. 

• ∆εν υπάρχει χρονοκαθυστέρηση για τον Τοπικό Συναγερµό. 
 

5.5.4 Καθυστέρηση Ειδοποίησης 
> 4. Alert Delay > OK > ����/���� για να δείτε τη λίστα > ΟΚ για αποθήκευση 

Σηµείωση: 
Μπορείτε να ρυθµίσετε τον χρόνο καθυστέρησης της Ειδοποίησης. Χρησιµοποιείται για την απενεργοποίηση λανθασµένων 
συναγερµών ή για κάποιες λανθασµένες λειτουργίες. 
 

5.5.5 Αλλαγή Κωδικού Ασφαλείας 
> 5. Change PWD > OK > Εισαγωγή του νέου κωδικού ασφαλείας (1-6 αριθµοί ή γράµµατα) 

> ΟΚ > Confirm Input (Επιβεβαίωση εισαγωγής) > ΟΚ για αποθήκευση 
Σηµείωση: 
• Ο νέος κωδικός ασφαλείας ισχύει µετά την Επιβεβαίωση Εισαγωγής. 
• Πρέπει να ρυθµίσετε τον κωδικό ασφαλείας, αλλιώς δεν µπορείτε να χρησιµοποιηθεί σωστά ο συναγερµός. 
 

5.5.6 Επεξεργασία Αισθητήρα RF 
> 6. Edit RF Sensor > OK > .... / .... για να δείτε τη λίστα 

> 1. Defense Area (Περιοχή Άµυνας) > ΟΚ > Edit and Input (Επεξεργασία και Εισαγωγή) > ΟΚ 
                                                     > Set Type (Ρύθµιση Τύπου): Main (Κεντρικό) / Normal (Κανονικό) > ΟΚ 
                                                     > Αποθήκευση 
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> 2. Remote Key (Αποµακρυσµένος Κωδικός) > ΟΚ > Edit (Επεξεργασία) > ΟΚ 
                                                                 > Child Key (Κωδικός Παιδιού): On / Off > OK > Αποθήκευση 
 

Σηµείωση: 
• Σύµβολο V: ∆είχνει ότι ο κωδικός έχει ρυθµιστεί µε επιτυχία. 
• Ρύθµιση περιοχής άµυνας: Επεξεργασία του ονόµατος και του τύπου της περιοχής άµυνας. 
                             ΧΧ                                        xxxxxxxxxxxxxxxxxxxxx                      V / IV 
                   Αριθµός περιοχής                                 Ονοµασία περιοχής                    Κυρίως περιοχή άµυνας: IV 
                          1 – 14                                                 1 – 10                              Κανονικό: V 
• Ρύθµιση ειδικής περιοχής άµυνας: Επεξεργασία της ονοµασίας της περιοχής άµυνας 

 
                             ΧΧ                                        xxxxxxxxxxxxxxxxxxxxx                      SV 
                   Αριθµός περιοχής                                 Ονοµασία περιοχής                    Ειδική περιοχή άµυνας 
                          15 – 16                                                 1 – 10                               
• Μορφή αποµακρυσµένου κωδικού: 
                            Α ~ Ε                                                          vvvv                                           c 
                Αριθµός χειριστηρίου                                  Η ρύθµιση είναι ΟΚ               Αναφορά λειτουργίας: C 
                                                                                                                          Κανονικό: Άδειο        
 

5.5.7 Αναζήτηση Κωδικού RF 
> 7. RF Code Query > OK 

> Ενεργοποιήστε τους ανιχνευτές ή πατήστε το χειριστήριο 
> Εµφάνιση της κατάστασης λειτουργίας των ανιχνευτών και της περιοχής άµυνας των τηλεχειριστηρίων. 
 

6. Λειτουργίες Συναγερµού 
ΣΗΜΕΙΩΣΗ: Προκαθορισµένος κωδικός ασφαλείας: 1111 (∆είτε το Αλλαγή Κωδικού Ασφαλείας) 
 

6.1 Ρύθµιση του Ολικού Συναγερµού 
Όταν δεν είναι κάποιος στο σπίτι, θα πρέπει να ενεργοποιείτε το συναγερµό (όλες τις περιοχές άµυνας) για να φυλάσσεται από 
κλοπή, πυρκαγιά, διαρροή αερίου κλπ. 
• Αποµακρυσµένος Οπλισµός µέσω Γραπτού Μηνύµατος 
Αποστολή του γραπτού µηνύµατος στη συσκευή: 
Κωδικός Ασφαλείας A (παράδειγµα: 1111Α) 
Το γραπτό µήνυµα απαντά: 
All Armed Mode activated (Λειτουργία Ολικού Οπλισµού ενεργοποιήθηκε). 
Η λειτουργία Ολικού Συναγερµού θα ενεργοποιηθεί απευθείας (µε) αφού το τερµατικό λάβει αυτή την εντολή µε γραπτό 
µήνυµα. Η οθόνη LCD εµφανίζει την ένδειξη  
• Οπλισµός µέσω Τηλεχειριστήριου 
Στην κατάσταση αναµονής > πατήστε το πλήκτρο      στο τηλεχειριστήριο > Καθυστέρηση Οπλισµού ΧΧ 
                                       > Οπλισµένο: η ένδειξη        εµφανίζεται στην οθόνη LCD 
• Οπλισµός µέσω Πληκτρολογίου 
Στην κατάσταση αναµονής > πατήστε το πλήκτρο      του πληκτρολογίου > Εισάγετε τον κωδικό ασφαλείας > ΟΚ 
                                       > Επιλέξτε All Armed (Όλα Οπλισµένα) > ΟΚ > Καθυστέρηση Οπλισµού ΧΧ 
                                       > Οπλισµένο: η ένδειξη      εµφανίζεται στην οθόνη LCD 
 

6.2 Ρύθµιση Τοπικού Συναγερµού 
Όταν κάποιος είναι στο σπίτι, µπορείτε να ρυθµίσετε κάποιο τοπικό συναγερµό στο σπίτι σας (ενεργοποιούνται οι κυρίως 
περιοχές άµυνας) για να το φυλάξετε από κλοπή, καπνό, αέριο κλπ. Για παράδειγµα, µπορείτε να ρυθµίσετε την περιοχή άµυνας 
αερίου και την περιοχή άµυνας πόρτας / παραθύρου ως κυρίως περιοχές. 
Η λειτουργία τοπικού συναγερµού µπορεί να ενεργοποιηθεί άµεσα (χωρίς χρονοκαθυστέρηση). 
• Αποµακρυσµένος Τοπικός Οπλισµός 
Αποστολή του γραπτού µηνύµατος στη συσκευή: 
PWD L (Κωδικός Ασφαλείας L) 
Το γραπτό µήνυµα απαντά: 
Local Armed Mode activated (Λειτουργία Τοπικού Οπλισµού ενεργοποιήθηκε). 
Όταν ενεργοποιηθεί, εµφανίζεται στο σύµβολο       στην οθόνη LCD. 
• Τοπικός Οπλισµός µέσω Τηλεχειριστήριου 
Στην κατάσταση αναµονής > πατήστε το πλήκτρο      στο τηλεχειριστήριο 
                                       > Τοπικός Οπλισµός: η ένδειξη     εµφανίζεται στην οθόνη LCD 
• Τοπικός Οπλισµός µέσω Πληκτρολογίου 
Στην κατάσταση αναµονής > πατήστε το πλήκτρο       του πληκτρολογίου > Εισάγετε τον κωδικό ασφαλείας > ΟΚ 
                                      > Επιλέξτε Local Armed (Τοπικός Οπλισµός) > ΟΚ >  
                                      > Τοπικός Οπλισµός: η ένδειξη      εµφανίζεται στην οθόνη LCD 
 

6.3 Ρύθµιση Απενεργοποίησης Οπλισµού 
Όταν είστε στο σπίτι ή θέλετε να αποφύγετε λανθασµένο συναγερµό, µπορείτε να απασφαλίσετε το σπίτι σας. Όταν 
ενεργοποιηθεί η λειτουργία απενεργοποίησης οπλισµού, τα σύµβολα             θα εξαφανιστούν από την οθόνη LCD. 
• Αποµακρυσµένη Απενεργοποίηση Οπλισµού 
Αποστολή του γραπτού µηνύµατος στη συσκευή: 
PWD C (Κωδικός Ασφαλείας C) 
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Το γραπτό µήνυµα απαντά: 
System deactivated (Το σύστηµα απενεργοποιήθηκε). 
• Απενεργοποίηση Οπλισµού µέσω Τηλεχειριστήριου 
Στην κατάσταση αναµονής > πατήστε το πλήκτρο ..... στο τηλεχειριστήριο 
                                       > Απενεργοποίηση Οπλισµού: η ένδειξη .... / .... εξαφανίζεται  
• Απενεργοποίηση Οπλισµού µέσω Πληκτρολογίου 
Στην κατάσταση αναµονής > πατήστε το πλήκτρο .... του πληκτρολογίου > Εισάγετε τον κωδικό ασφαλείας > ΟΚ 
                                      > Απενργοποίηση Οπλισµού: εξαφανίζεται η ένδειξη .... / .... 
 

6.4 Λειτουργία Ειδοποίησης 
6.4.1 Ενεργοποίηση Ειδοποίησης 
• Κανονική (κυρίως) περιοχή άµυνας: Περιοχή άµυνας 1 – 14. Στην κατάσταση Ολικού ή Τοπικού Οπλισµού, όταν οι 

ανιχνευτές σηµάνουν συναγερµό, το σύστηµα µπαίνει στη διαδικασία ειδοποίησης. 
• Ειδική περιοχή άµυνας: Περιοχή άµυνας 15 – 16. Οποιαδήποτε στιγµή οι ανιχνευτές σηµάνουν συναγερµό, το σύστηµα 

µπαίνει στη διαδικασία ειδοποίησης. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Ρύθµιση συναγερµού (Ολικός / Τοπικός Οπλισµός) 
 

Η περιοχή άµυνας αναφέρει έναν συναγερµό. 

Η οθόνη LCD εµφανίζει την περιοχή συναγερµού και 

 

Καθυστέρηση συναγερµού 

Στέλνεται γραπτό µήνυµα ειδοποίησης στους 
παραλήπτες αυτόµατα. 
 
 

Γραπτό µήνυµα ειδοποίησης: xxxxxx Alert 
Xxxxxx ----- ονοµασία περιοχής άµυνας 

 

Αρχίζει να ηχεί η σειρήνα. 

Η αυτόµατη κλήση καλεί τον πρώτο παραλήπτη 

 

Η αυτόµατη κλήση καλεί το δεύτερο παραλήπτη 

 

Η αυτόµατη κλήση καλεί τον τρίτο παραλήπτη 

 

Αν δεν υπάρχει απάντηση σε 30” 

Αν δεν υπάρχει απάντηση σε 30” 

Αν δεν απαντά κανείς 

Η σειρήνα ηχεί για 90 δευτερόλεπτα. Η ένδειξη      
εξαφανίζεται. 
Η διαδικασία ειδοποίησης ολοκληρώνεται.  
 
Το σύστηµα βρίσκεται ακόµα στην κατάσταση Ολικού / 
Τοπικού Οπλισµού. 

 

• Ο παραλήπτης απαντά 
• Η σειρήνα σταµατά να 

ηχεί 
• Ο παραλήπτης ελέγχει 

το σπίτι 

Ακύρωση Ειδοποίησης 
 

Το         εξαφανίζεται 
 

Σταµατά η ειδοποίηση 
 

 Κατά τη διάρκεια του 
συναγερµού 90 

δευτερολέπτων, δεν 
µπορεί να 

ενεργοποιηθεί νέος 
συναγερµός. 
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6.4.2 Ακύρωση Ειδοποίησης 
Μπορείτε να ακυρώσετε µια ειδοποίηση, κατά τη διάρκεια της χρονοκαθυστέρησης ή κατά τη διάρκεια των ειδοποιήσεων. 
• Μέσω Συναγερµού: Ακύρωση ειδοποίησης, το σύστηµα µπαίνει σε νέα λειτουργία οπλισµού. 
• Μέσω Απενεργοποίησης Οπλισµού: Ακύρωση ειδοποίησης, το σύστηµα αφοπλίζεται. 
Σηµείωση: Η λειτουργία ακύρωσης ειδοποίησης µπορεί να καθυστερήσει σε περίπτωση που το σύστηµα είναι απασχοληµένο. 
 

6.5 Ειδοποίηση SOS 
Ενεργοποίηση Ειδοποίησης SOS: Σε περίπτωση έκτακτης ανάγκης, πατήστε το πλήκτρο «!» στα τηλεχειριστήρια ή στο 
τερµατικό για να ενεργοποιήσετε την Ειδοποίηση SOS. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.5.2 Ακύρωση Ειδοποίησης SOS 
Μπορείτε να ακυρώσετε την ειδοποίηση SOS κατά τη διάρκεια της χρονοκαθυστέρησης ή κατά τη διάρκεια των ειδοποιήσεων. 
• Μέσω Συναγερµού: Ακύρωση ειδοποίησης, το σύστηµα µπαίνει σε νέα λειτουργία οπλισµού. 
• Μέσω Απενεργοποίησης Οπλισµού: Ακύρωση ειδοποίησης, το σύστηµα αφοπλίζεται. 
Σηµείωση: Η λειτουργία ακύρωσης ειδοποίησης µπορεί να καθυστερήσει σε περίπτωση που το σύστηµα είναι απασχοληµένο. 
 

7. Λειτουργία Αναφοράς 
7.1 Αναφορά Παιδιού 
Μπορείτε να ρυθµίσετε ένα τηλεχειριστήριο για χρήση αναφοράς παιδιού. Το παιδί πιέζει το σχετικό πλήκτρο για να στείλει 
γραπτό µήνυµα στον πρώτο παραλήπτη αυτόµατα. 
• Πιέστε το πλήκτρο     στο χειριστήριο του παιδιού: Ο συναγερµός ενεργοποιείται 

> Στέλνεται αυτόµατα γραπτό µήνυµα στον πρώτο παραλήπτη: I have left the house (X) (Έφυγα από το σπίτι) 
• Πιέστε το πλήκτρο      στο χειριστήριο του παιδιού: Απενεργοποιείται ο συναγερµός 

> Στέλνεται αυτόµατα γραπτό µήνυµα στον πρώτο παραλήπτη: I have returned home safe (Χ) (Γύρισα στο σπίτι 
ασφαλής) 

 

7.2 Αναφορά Εργασίας 
Όταν όλα τα τηλεχειριστήρια (Μέγιστος αριθµός: 5 τεµ.) έχουν ρυθµιστεί για χρήση αναφοράς, οι υπάλληλοι πατούν τα πλήκτρα 
του χειριστηρίου για να στείλουν γραπτό µήνυµα στο διευθυντή τους (ως πρώτο παραλήπτη) αυτόµατα, για να αναφέρουν την 
παρουσία τους στη δουλειά. 
Οι ταυτότητες των υπαλλήλων µπορούν να διαχωριστούν (X: A, B, C, D, E) στο γραπτό µήνυµα. 

 

Έκτακτη Ανάγκη 

Α: Πατήστε το ! στο τηλεχειριστήριο 
 
Β: Πατήστε το ! στο τερµατικό 

 

Καθυστέρηση συναγερµού 

Αποστέλλεται γραπτό µήνυµα SOS στους παραλήπτες 
αυτόµατα 
Γραπτό µήνυµα: SOS! I am in danger at home! 
Please help! (SOS! Κινδυνεύω στο σπίτι! Παρακαλώ 
βοηθήστε µε!) 

Η αυτόµατη κλήση καλεί τον πρώτο παραλήπτη 

Η αυτόµατη κλήση καλεί το δεύτερο παραλήπτη 

Η αυτόµατη κλήση καλεί τον τρίτο παραλήπτη 

Η ειδοποίηση SOS σταµατά σε 90 δευτερόλεπτα. 
 

(Το σύστηµα είναι ακόµα στην προηγούµενη κατάστασή του) 

 

 
• Ο παραλήπτης απαντά 

 
• Ο παραλήπτης ελέγχει 

το σπίτι 

 

Ακύρωση 
Ειδοποίησης SOS 

Σταµατά η 
ειδοποίηση 

 

Αν δεν απαντά κανείς 

Αν δεν υπάρχει απάντηση σε 30” 

Αν δεν υπάρχει απάντηση σε 30” 

Κατά τη διάρκεια του 
συναγερµού 90 

δευτερολέπτων, δεν 
µπορεί να ενεργοποιηθεί 

νέος συναγερµός. 
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Σηµείωση: 
• Το Χ στο γραπτό µήνυµα δείχνει τον αριθµό των χειριστηρίων. 
• Ρύθµιση χειριστηρίων: (∆είτε το Edit RF Sensor (Ρύθµιση Αισθητήρα RF) > Child Key Function (Λειτουργία 

Πλήκτρου Παιδιού): On) 
 

ΠΑΡΑΡΤΗΜΑ 
1. Ρύθµιση Κωδικού RF 
Στην κατάσταση αναµονής: Πατήστε * 8566 # > ����/���� για να δείτε τη λίστα > (∆είτε το: Επεξεργασία Αισθητήρα 
RF) 
• Για να δηµιουργήσετε µία νέα περιοχή άµυνας: 
Το τερµατικό υποστηρίζει µέχρι 16 αισθητήρες για διαρροή αερίου, άνοιγµα πόρτας, καπνό και ανιχνευτές υπερύθρων κλπ. Θα 
πρέπει να ρυθµιστούν διαφορετικές περιοχές άµυνας σε διαφορετικούς κωδικούς RF πριν την πρώτη χρήση. 
> 1. Defense Area > OK 
> MENU: Delete (∆ιαγραφή) / Edit (Επεξεργασία) > Edit and Input (Επεξεργασία και Εισαγωγή) (1 – 10) > ΟΚ 
> Choose Type (Επιλογή Τύπου): Main (Κυρίως) / Normal (Κανονικό) > ΟΚ 
> Βήµα (σύµφωνα µε τις οδηγίες) 
> Ενεργοποίηση αισθητήρα, στην οθόνη εµφανίζεται ο κωδικός εγγραφής: xxxxxx 
> Απενεργοποίηση αισθητήρα, πιέστε το ����. Επαναλάβετε τα προηγούµενα βήµατα ξανά. Απενεργοποιήστε τον αισθητήρα και 
πιέστε το ����  
> Ο αντίστοιχος κωδικός RF θα αποθηκευτεί. 
• Για να δηµιουργήσετε νέο τηλεχειριστήριο: 
Υποστηρίζονται µέχρι 5 τηλεχειριστήρια. Τα τηλεχειριστήρια αναφέρονται στο µενού. 
> 2. Remote Key > OK > Edit (επεξεργασία) > OK 
> Βήµατα (σύµφωνα µε τις οδηγίες) 
> Πιέστε οποιοδήποτε πλήκτρο του τηλεχειριστήριου, η οθόνη LCD εµφανίζει: Κωδικός Εγγραφής xxxxxx 
   πιέστε το ���� 
> Επαναλάβετε τα προηγούµενα βήµατα: πιέστε το ίδιο πλήκτρο του χειριστηρίου και µετά πιέστε το ���� 
> Επιλέξτε: Λειτουργία πλήκτρου παιδιού 
> ΟΚ Αποθήκευση > Exit (Έξοδος) 
ΣΗΜΕΙΩΣΗ: 
− Η ένδειξη V V V V δείχνει ότι και τα τέσσερα πλήκτρα του χειριστηρίου έχουν ανατεθεί. 
− Η ένδειξη V V V V C δείχνει ότι το χειριστήριο έχει οριστεί ως χειριστήριο παιδιού. 
 

• ∆ιαγραφή αισθητήρων RF και τηλεχειριστηρίων 
> 3. Delete All (∆ιαγραφή όλων) 
> ΟΚ > Are you sure? (Είστε σίγουροι;) > ΟΚ / Exit (Έξοδος) 
 

2. Έλεγχος Αισθητήρων και Τηλεχειριστηρίων 
Εγκαταστήστε τις µπαταρίες στους αισθητήρες και επιχειρήστε να ενεργοποιήσετε τους αισθητήρες. Μετά ελέγξτε τους στο 
MENU. 
MENU > 5. Alarm Setup (Ρύθµιση Συναγερµού) > ΟΚ > PWD (Κωδικός Ασφαλείας) > 7. RF Code Query 
(Αναζήτηση Κωδικού RF) > ΟΚ 
> Ενεργοποιήστε τους ανιχνευτές ή πιέστε το χειριστήριο 
> Εµφάνιση κατάστασης περιοχής άµυνας ανιχνευτών και τηλεχειριστηρίων  
 

3. Ανιχνευτές 
• Αισθητήρας Πόρτας / Παραθύρου  
Χαρακτηριστικά: 
• Απαιτήσεις ισχύος: DC = 12V – 8.4V (A23 DC = 12V η µπαταρία περιλαµβάνεται) 
• Κατανάλωση ρεύµατος: λιγότερη από 20µΑ. Λιγότερη από 15µΑ ενώ εκπέµπει 
• Εκποµπή: συχνότητα --- 433 / 315 ± 0.2MHz  
• ∆ιάρκεια εκποµπής: λιγότερο από 1 δευτερόλεπτο 
• Απόσταση εκποµπής από τον ξενιστή: περισσότερο από 80 µέτρα  

(χωρίς εµπόδια, τραβήξτε έξω όλη την κεραία) 
• Θερµοκρασία: -10°C έως 40°C 
• Υγρασία: λιγότερη από 90% 
 

Εγκατάσταση 
 

Ορίζουµε τη µαγνητική επαφή πόρτας / παραθύρου για δύο µέρη: µέρος Α και µέρος Β. Πρώτα 
βάλτε την µπαταρία στο µέρος Α και µετά, σύµφωνα µε το σχέδιο, ενώστε το µέρος Α και το µέρος 
Β (µε βίδες) πάνω στην πόρτα ή στο παράθυρο που θέλετε να ελέγχετε. Είναι καλύτερο αν η 
απόσταση µεταξύ τους είναι µικρότερη των 15 χιλιοστών. 

 

Χρήση 
Θα πρέπει να τραβήξετε όλη την κεραία προς τα έξω και µετά να ανοίξετε το παράθυρο ή την 
πόρτα που θέλετε να ελέγχετε. Θα φαίνεται η ένδειξη λειτουργίας. Την ίδια στιγµή, ο ξενιστής θα 
σηµάνει συναγερµό. Αν δεν φαίνεται η ένδειξη λειτουργίας ή αν δεν σηµάνει συναγερµό ο ξενιστής, 
παρακαλούµε ελέγξτε αν έχει ανάψει η ένδειξη χαµηλής παροχής ρεύµατος. Αν ναι, παρακαλούµε 
αλλάξτε την µπαταρία. Αν όχι, παρακαλούµε επικοινωνήστε µε το τµήµα εξυπηρέτησης πελατών. 

 

Ένδειξη LED χαµηλής 
παροχής ρεύµατος 

Ένδειξη λειτουργίας  

 

Ταινία διπλής όψης 
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• Ασύρµατος ευρυγωνικός ανιχνευτής PIR / Ανιχνευτής PIR για να µην επηρεάζεται από µικρά ζώα 
Χαρακτηριστικά του Ανιχνευτή PIR 
2.1 Θερµοκρασία Λειτουργίας: -10°C έως 50°C 
2.2 Υγρασία: 5% έως 95% 
2.3 Βολτ Λειτουργίας: 3V (CR123A) 
∆ιάρκεια ζωής της µπαταρίας: µπορεί να χρησιµοποιηθεί για δύο χρόνια 
2.4 Ρεύµα Λειτουργίας: ≤ 120uA (αδρανής) - ≤ 13mA (δυναµικός) 
2.5 Αισθητήρας: Αισθητήρας PIR διπλού στοιχείου 
2.6 Κάλυψη: 6 – 8 µέτρα µήκος, 100° (ΕΙΚ. 1) 
2.7 Ύψος Εγκατάστασης: Περίπου 2.1 µέτρα (προτεινόµενο) 
2.8 Απόσταση Εκποµπής: ≥ 200 µέτρα (άµεσα και γραµµικά) 
2.9 Ασύρµατη Συχνότητα: 433 / 315 MHz 
2.10 Ασύρµατη Κωδικοποίηση: 1527 / 2240  
 

Εγκατάσταση 
Πρώτα εισάγετε την µπαταρία. 
Μετά βιδώστε το µπράτσο του ανιχνευτη στον τοίχο και µοντάρετε τον ανιχνευτή. Το ιδανικό προτεινόµενο ύψος είναι 2.1 
µέτρα και να κρατάτε την πρόσοψη του ανιχνευτή προς τα κάτω σε γωνία 6 ~ 12 µοιρών προς τον τοίχο. 
Για να αποφύγετε την λανθασµένη ενεργοποίηση του συναγερµού και να διατηρήσετε µία φυσιολογική κατάσταση λειτουργίας, 
κρατήστε τον ανιχνευτή µακριά από κλιµατιστικά, ηλεκτρικούς ανεµιστήρες, παράθυρα ή άλλα αντικείµενα, όπως ψυγεία, 
φούρνους κλπ, που µπορεί να προκαλέσουν αλλαγή στη θερµοκρασία. Μην τον στοχεύετε σε πηγές θερµότητας. Μην τον 
εκθέτετε σε ρεύµατα αέρα. Μην τον εγκαθιστάτε σε εξωτερικούς χώρους. Να τον µοντάρετε σε συµπαγείς, σταθερές επιφάνειες. 
Να µην έρχεται σε επαφή µε απευθείας ηλιακό φως. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ένδειξη Χαµηλής Παροχής Ρεύµατος 
Όταν η ένδειξη LED γίνει πράσινη, σηµαίνει ότι η µπαταρία µέσα στον ανιχνευτή είναι αδύναµη και πρέπει να αντικατασταθεί. Ο 
ανιχνευτής θα σταµατήσει να εκπέµπει σήµατα. 
Τύπος µπαταρίας: CR123A, Κύτταρο λιθίου υψηλής χωρητικότητας. 
 

Αποκλειστική διάθεση στην Ελλάδα: ΤΗΛΕΜΑΡΚΕΤΙΝΓΚ Α.Ε. ΣΟΛΩΜΟΥ 56 - 14234 Ν. ΙΩΝΙΑ - 210 2708250 
 

 

ΠΑΝΩ ΠΛΑΙ 

∆εν επηρεάζεται από µικρά ζώα 

Κανονικό 

Εικ. 1 Ακτίνα κάλυψης και εµφάνιση 

Εικ. 2 Ανίχνευση ευαισθησίας του Ανιχνευτή PIR 

Αισθητήρας PIR διπλού στοιχείου 

Φακός Fresnel 
Πιο Ευαίσθητη 
Κατεύθυνση Κίνησης 


